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ABSTRACT 

The mechanism of diffused water through the surface of archaeological Obsidian blades, in the course of time, 
a mainly temperature-dependent and concentration-driven phenomenon, related to the obsidian hydration 
dating (OHD), is a subject of ongoing development. Fourteen obsidian specimens from California, Easter Is-
lands, and Africa of laboratory ageing and known age spanning from some hundreds to some thousands of 
years have been investigated. The microscope images of micro-scale thin hydration rims of naturally hydrated 
artifacts and experimentally hydrated ones have been processed. It has been shown that the high-temperature 
aged experiments data of an obsidian source (as image area in pixels and hydration depth) can be properly 
processed to calculate the age of an obsidian artifact derived from the same source, although it may be applied 
to different and distant obsidian sources.  
The first novel power law approach is presented exploring various facets of the thin-sectioned images of ab-
sorbed water from obsidian surfaces. 
Hydration growth rates calculated from areal pixels, a power law functional behavior of temperatures of ex-
perimentally hydrated layers with growth per year, as well as, their hydration thickness, is discussed. The 
obtained ages from the tentative power law equation are estimated for anticipated environmentally effective 
temperatures. Compatibility and differences with conventional OHD ages, reporting problematic reported 
data and image scaling issues, are critically discussed, maintaining the logic that the present and future appli-
cation should be made on a similar or closely related source of both the sample to be dated and the experi-
mental simulation samples at high temperatures. 
 
 
 
 
 

KEYWORDS: obsidian hydration dating, power law, temperature, microscopic, growth rate, temperature, 
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1. INTRODUCTION 

Diffusion is an essential transport mechanism in 
many rock and biological systems and is known to be 
susceptible to environmental and intrinsic structure 
and inhomogeneity. The most basic definition of dif-
fusion is that it presumes a homogeneous environ-
ment with a continuously increasing mean squared 
displacement and a Gaussian distribution of particle 
displacements. When inhomogeneities exist in the en-
vironment, the connections between diffusing partic-
ulate and the mineral or cellular structure result in 
challenging displacement distributions, which are 
most widely classed as non-Gaussian (Hall and Ingo 
2021). 

The value of power law exponents has been pro-
posed to construct universality classes that capture 
the dimensionality and type of disorder inherent in 
the diffusion environment (Novikov et al., 2014).  

Friedman and Smith (1960) approached the dating 
of obsidian stone tools from the last time they were 
used by prehistoric people, observing that a newly ex-
posed surface of obsidian takes on water from the en-
vironment at a known rate that can be used to calcu-
late the time elapsed since exposure and, thus, the 
date of an obsidian artifact's production. Following 
that, the hydration technique was further investi-
gated, and several variations of the so-called obsidian 
hydration dating (OHD) method were created, pro-
posing both empirical and intrinsic rate methods. Sec-
ondary ion mass spectroscopy (SIMS) has been used 
over the last 20 years to properly quantify the hydra-
tion profile (water content vs depth) in a phenome-
nology manner. Models explaining the diffusion pro-
cess are used to determine the age by modeling the 
hydration profile (Liritzis & Laskaris, 2021)  

Even today, sixty-three years after the launch of the 
obsidian hydration dating approach, the precise 
mechanism by which water diffusion takes place in 
amorphous rhyolitic glass such as obsidian is still un-
der investigation (Doremus 1969, 2000, 2002; Crank 
1975, Zhang et al. 1991; Nowak and Behrens 1995; 
Zhang and Behrens 2000; Anovitz et al. 2006). Dore-
mus (2000) proposed a hypothesis for water diffusion, 
a theoretical model known as the "diffusion-reaction 
model." According to the suggested model, the water 
in the burial environment interacts with the Si-O-Si 
clusters to generate silanol groups (eq. 1). 

H2O + Si-O-Si ⇋2SiOH (1) 

Additional research (Stevenson et al., 2000, 2021) 
revealed that the water molecules on the obsidian sur-
faces are the primary molecules that disperse in the 

obsidian interface and that the newly generated si-
lanol groups (Si-O-H) stay stable throughout diffu-
sion in the bulk matrix. 

Water diffusion is a complicated and dynamic pro-
cess at the start of the diffusion process, as evidenced 
by accelerating hydration tests (Anovitz et al., 2004; 
Stevenson and Novak, 2011; Stevenson et al., 2019). 
As a result of diffusion, hydration has a high surface 
concentration while the diffusion coefficient de-
creases (Liritzis 2014). Following up on Liritzis' tech-
nique, it has been proposed that this change may be 
due to glass surface relaxation when tension in the 
near-surface region is released (Liritzis 2006, 2014; 
Liritzis and Laskaris, 2012). 

The water from the burial site is absorbed by the 
obsidian's surface, resulting in the production of a hy-
dration rim at its interface layer (a few microns under 
the surface). The hydration of obsidians is a complex, 
diffusion-based phenomenon that is greatly influ-
enced by temperature, the intrinsic (structural) water 
of the artifact, water concentration on the glass sur-
face and the glass matrix and micro-crystallization 
but also relative humidity (RH) (Mazer et al., 1991; 
Liritzis et al., 2004, 2007, 2008). 

The variable temperature of the burial environ-
ment and various factors participating in the diffu-
sion process during the tool’s lifetime contribute to 
the final shape of the diffusion profile (concentration 
vs depth), the SIMS sigmoid curve (Liritzis t al., 2008; 
Liritzis and Laskaris 2012). 

For dating purposes, Friedman & Smith (1960) sug-
gested the empirical power law equation (eq. 2): 

𝑥2=𝑘*𝑡 (2) 

Where x is the thickness of the hydration rim in mi-
crons (μm), t is the age in years, k is the hydration rate 
at a particular temperature/relative humidity (Fried-
man & Long 1976; Liritzis 2014; Liritzis and Laskaris, 
2021).  

For water to penetrate obsidian, a water molecule 
must have enough energy to stretch the glass matrix 
and enter one of the spaces in between. This energy is 
directly related to the temperature in Kelvins, which 
means that the rate of hydration is dependent on tem-
perature. The specific relationship is described by the 
Arrhenius equation: 

k = A*exp(-Q/T) (3) 

Here, A is a constant that determines the rate of hy-
dration, Q is the energy needed to activate the pro-
cess, and T is the temperature in Kelvins. The pre-ex-
ponential constant A is measured in square microme-
ters per unit of time, while Q and T are measured in 
Kelvins (which can be calculated by adding 273.15 to 
the temperature in Celsius). This information is based 
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on research by Doremus (2002) and Friedman and 
Long (1976). 

Eq.3 is essentially the hydration rate k (μm2/day) 
of Arrhenius as in eq. 4: 

𝑘=𝐴*𝑒−𝐸/𝑅𝑇 (4) 

T is the absolute temperature (Kelvin, K) which 
represents the effective hydration temperature (EHT), 
k is the diffusion coefficient (μm2/day), A pre-expo-
nential replacement, as a source-specific constant, E 
the activation energy (joules per mole) again as a 
source or burial environment’s constant and R the gas 
constant (8.314 J / mol·K joules per degree per mole). 
The energy has not been satisfactorily addressed as 
dependent on environmental context factors affecting 
chemical reaction, which must be considered (See AP-

PENDIX, Activation Energy). 
The primary issue in all techniques is determining 

the "effective temperature" T, which determines the 
diffusion rate. (for more on thermal history and effec-
tive temperature, see Smith et al., 2003). This is the 
temperature required to produce equivalent hydra-
tion rim as the fluctuating temperature over the iden-
tical archaeological duration. EHT can never be lower 
than the mean temperature, as per the Arrhenius 
equation's mathematical structure. The average tem-
perature experienced by the artifact during its inter-
ment period is known as the burial period's mean 
temperature.  

Using MatLab runs for typical archaeological con-
ditions the best fit for EHT calculation was derived 
simplified from the equivalent equation in Rogers 
(2007). 

EHT = Ta + 0.0062∗(V2
a+ V2

d) (5) 

where Ta is the average annual temperature, Va is 
the annual variation (hottest-month mean minus 
coldest-month mean) and Vd is mean diurnal temper-
ature (all in °C).  

Three dating approaches were proposed to solve 
this issue, both of which sought to quantify the rate at 
which water diffuses through glass: 

Though initially the relationship between hydra-
tion depth (as determined by microscopy, SIMS, or 
other means) and the 14C dates were examined with 
which the measured obsidian samples are strictly 
stratigraphically associated context-wise, no any cali-
bration was possible. Taking up this relationship Rog-
ers and Stevenson (2023) determined Hydration rates 
by obsidian-radiocarbon association and the science-
based model have an accuracy between 5% and 13%, 
based on obsidian source. Although it is possible to 
create an ad hoc best-fit equation from archaeological 
data for a specific analysis, the authors conclude there 
is no assurance that it will be valid beyond the data 

set on which it is based, and the procedure was not 
recommended. 

So far, the main methodological dating approaches 
used are:  

i. Following the conventional age eq (2) and 
calculating a hydration rate (k) of eq. 3, based on the 
activation E, temperature T and the Arrhenius equa-
tion for reaction kinetics (eq.4). This k value is either 
estimated from nearby sites of supposedly similar cli-
matic history (Pearson 1995, Stevenson et al. 1998, 
2001; Rogers 2008) or, in another approach (intrinsic 
rate), the k of eq. 4 is experimentally determined and 
coupled with accurate measurements of the site’s 
temperature to derive an age (Anovitz et al., 1999). 
Aged hydration at high T for same or different obsid-
ian sources helped calculating the rate, k. Although 
other equations than eq.2 have been proposed for 
Bodie Hills (e.g., Basgall and Giambastiani 1995; Pear-
son 1995), the depth is proportional to time power law 
tn where t is time and n = 0.5 within limits of experi-
mental error, i.e. the equation (2) is the only form with 
both theoretical (Ebert et al. 1991; Doremus 2002) and 
laboratory (Doremus 1994; Stevenson et al. 1998, 2000, 
2021; Anovitz et al., 2004) support. Age analysis by 
obsidian hydration requires knowledge of the hydra-
tion rate of the obsidian, so seven methods for 26 ob-
sidian sources for computing hydration rates were 
described, with mathematical details (Rogers and Ste-
venson 2022a). Hence, results have demonstrated that 
a simple square-root-of-time model of the evolution 
of the diffusion profile is not adequate to describe the 
diffusion process, as measured diffusion profiles ex-
hibit the effects of concentration- and time-depend-
ent, non-Fickian diffusion. This research is still going 
on yet the square-root-of-time model prevails. 

ii. Rogers and Stevenson (2022a, 2024) tried to 
produce a calibration equation relating to Water con-
tent (W), EHT and K. The hydration rates computed 
are based on eq.3 of high T aged obsidians with vari-
ous water content. The normalized activation energy, 
E, from equation (2), was related to W (weight percent 
H2Ot). Measuring water content of a specimen, either 
by IR spectroscopy or by the Structural Water deter-
mination method described (Rogers and Stevenson 
2022b, 2023; Franchetti et al., 2024), the authors main-
tain that this is a simple step any archaeologist can 
make to improve OHD accuracy and precision fol-
lowing the eq. 2 again for the age estimation. When 
the obsidian parameters A and E/R are known, from 
the Arrhenius plot LnK versus 1/T, the hydration rate 
can be computed for any desired temperature and the 
dates are calculated from eq 2 and for different T. 

iii. By using the idea of a surface saturation (SS) 
layer, and applying ion bombardment using SIMS on 
the surface, the obtained H+ depth profile was fitted 
by polynomial functions and following the diffusion 
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law an age equation is produced (Liritzis and Dia-
kostamatiou 2002; Liritzis et al., 2004; Liritzis 2014, 
2006; Liritzis & Laskaris 2009; 2021). In the Liritzis’ 
method the flux F (mass per unit area per unit time) 
of a substance diffusing into another substance is 
based on Crank’s diffusion equation between concen-
tration C, time t and diffusion coefficient D (Liritzis et 
al., 2004; Liritzis 2006, 2014). In the case of a semi-in-
finite medium with steady boundary conditions, as-
suming the process is pure diffusion, and no chemical 
reaction is taking place and the assumption that the 
diffusion coefficient is constant, the solution to the 2nd 
order partial derivative operator equation can be 
shown to be: 

C = C0 erfc(z) (6) 

where C is the water concentration at depth x and 
time t, C0 is the concentration at the surface, and erfc 
is the complementary error function (Crank 1975). 
Following Crank (1975), the argument z in eq. (6) is 

z= x/(Dt)1/2 (7) 

where x is depth into the obsidian, t is time, and D 
is the diffusion coefficient. 

Equation (7) describes the variation of concentra-
tion both in space and time. The hydration front is 
usually defined as the point where C/C0 reaches 
some set value, or in other words the point where z 
equals a constant. This is the surface saturation (SS) 
point close to surface (SIMS-SS method, Liritzis 2006, 
2014; Liritzis and Laskaris 2012).  

Equation (7) can then be rearranged as in eq.2 the 
form familiar from hydration studies since Friedman 
and Smith (1960). 

The SIMS-SS method and criteria of suitability has 
had several World applications (Liritzis and Laskaris 
2009; Liritzis et al., 2008). 

Regarding the burial temperature and hydration 
rate Rogers (2007) computed an effective hydration 
temperature from a numerical integration of the hy-
dration rate over the temperature model determining 
an EHT for each artifact, based on site elevation and 
burial depth, and applied a rim correction factor 
(RCF) to correct the rim value to a consistent reference 
temperature. For the hydration rate for Bodie Hills 
(BH) obsidian at 20°C a value of 14.31 μ2/1000 yrs was 
reported. The computed ages of the specimens from 
this region are compared with the calibrated radiocar-
bon ages so this is a per case issue. The standard de-
viation of the percentage error was relatively large, 
23%. In fact, approximately half of this deviation is at-
tributable to EHT errors, with the remaining most 

likely reflecting the poorly known chemistry and var-
iability of Bodie Hills obsidian (Rogers 2008b). Given 
the current level of knowledge of Bodie Hills obsid-
ian, it would be imprudent to assume an accuracy 
greater than roughly 20% in doing chronometric stud-
ies, according to Rogers (2008b). 

At any rate, the effect of temperature on hydration 
rate is significant and the result of the hydration layer 
expressed in terms of pixels and fractals is still an on-
going development. 

An earlier investigation on the variations of water 
and structural entities within the obsidian in the mi-
cron and nanoscale of divided hydration and pure ob-
sidian using fractals (Liritzis et al., 2024) indicated in-
teresting aspects of hydration medium and water-
front tail. A fractal variation along the hydration layer 
which mirrors somehow the S-like H+ concentration 
changes at depth.  

The present work focuses on the growth rate and 
its power law dependence of water in obsidians in 
various controlled temperatures extrapolated to envi-
ronmental temperatures, as well as on archaeological 
hydrated blades. Making use of the obtained rates 
tentative dates for five known age obsidian artifacts 
are made.  

The goal here is to investigate a) the functional de-
pendence of obsidian hydration growth as a function 
of temperature, b) the comparison between different 
laboratory-aged obsidians at 140-180oC and 160oC 
/30 days and 180oC/60 days, the respective hydration 
layer pixels of which are standardized in growth rates 
per day, and c) the extrapolation from high T oC to 
ambient temperatures (10-30 oC) and use of these tem-
perature values to recalculate the known ages based 
on normalized areal pixels, but also on the growth 
rate of hydration thickness per year. 

The approach also points the way to an interesting 
new research direction in obsidian hydration dating 
studies. We understand the limited number of cases 
in the use of data and therefore we consider the effort 
a first step towards further deepening. 
 

MATERIALS AND HYDRATED IMAGES 

Fourteen obsidian samples were processed. For ab-
breviations of their initials are used throughout the 
text. of Five (5) images of an obsidian source from 
Bodie Hills (BH1), California that have been experi-
mentally hydrated from 140, 150, 160, 170, 180oC for 
59.22 days (Fig.1) (Stevenson, CM pers. communica-
tion; Hughes 1984).  
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140oC 

 
150oC 

 

 
160oC 

 
170oC 

 
180oC 

 

Figure 1. Bodie Hills data (BH1). The five hydrated zones per laboratory experimental temperature for 59.22 days. The 
narrow yellowish zone is the hydration layer and on the right is the surface and the glass support (bluish), and on the 
left (darker) the inner obsidian. The thickness (μm) per temperature: 140oC (5.91um); 150oC (7.75um); 160oC (9.96um); 

170oC (13.29um); 180oC (18.09um). 

The BH source has proved most troublesome with 
traits consisting of two distinct forms. One gray-green 
bands intersected with much smaller quantities of 
clear bands containing black and white phenocrysts, 

and the other very dense black, red brown dendritic 
masses (see Bettinger et al., 1984). 

Two (2) African blades PE-21 and PE-23 (Fig.2) are 
coming from a cave in Africa of the Middle Stone Age 
Ethiopian rock shelter of Porc Epic which is supposed 
to date to approximately 60-70kya (Clark et al., 1984).  
 

(A) 

 

(B)   

Figure 2. Porc Epic obsidian hydration layers of a) PE 23, and, b PE-21 and areas measured by fractals and pixels. 
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The dark line on the surface of the layer has an op-
tical effect. Optical thin sections were prepared, and 
the hydration rims were photographed with a Motic 
2MB digital camera mounted on a Motic polarizing 
microscope at a magnification of 600x. The darker 
part near the diffusion front may be a difference in the 
refractive index of the glass but also lighting intensity. 
The refractive index of the layer is much higher than 

the bulk glass (~1.56 vs ~1.49). In fact, when a hydra-
tion layer is viewed with polarized light under 
crossed-Nicols a gradient can be seen in this region, 
but the birefringence intensity cannot be reliably 
tracked with distance. 

Two (2) Orito Obsidians, Easter Island (Orito) 
source, heated at 160oC/ 30 days and 160oC / 50 days 
Fig.3) (Tom Origer, pers. data). 

 

Figure 3. Orito Easter Island blades. RBC-600, hydrated layers for a)160 oC / 30 days enhanced, b) cropped, c) surface and 
diffusion front, and d) RBC-601, for 160 oC / 50 days; blue lines indicate the layer. (not in scale, pixels normalized to NV 

or BH of same area) 

Five (5) Napa obsidians from Napa Valley (NV) in 
northern California: NV-1.9, NV-2.8, NV-4.5, NV-5.9, 
and NV-7.7 (NV stands for Napa Valley and the num-
ber of hydration layers in microns). Three have been 
dated to: NV-1.9 472, 2650, and 7750 years old, found 
at different depths below surface ground. O-1346#27, 
0-10 cm(17.15 oC estimated by Rogers, pers. Comm.1) 
O-1346#37 at 20-30cm, (16.23 oC estimated by Rogers); 

 
1 The EHT has been calculated by Rogers from WRCC tem-
perature data for St Helena and Calistoga and computed 
temperature model parameters. The parameters for the 2 

and O-1346#56 at 90-100cm (15.76 oC estimated by 
Rogers) (Tom Origer pers. Communication). 

The two NV-2.8 and NV-5.9 are experimentally hy-
drated at 150oC / 10 days and 140oC / 60 days respec-
tively. (Fig.4) (Hughes 1984) 

The NV-5.9-micron specimen is from the same 
Napa Valley obsidian rock as the specimens with 1.9, 
4.5, and 7.7 micron measurements. 

sites were close but not identical, so he used the average. 
Then he made the adjustment for burial depth and com-
puted EHT.  
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(A) NV-4.5 

 
(B) NV-5.9 

 
(C ) NV-1.9 

 
(D) NV-2.8 

 
(E) NV-7.7 

Figure 4. Napa Valley hydration layers A) Slide O-1346 #27, 4.5 microns hydration rim Napa Valley of 2,646 years, B) 
NV-5.9. Here is an image of a hydration band (between the orange arrows) that measures 5.9 microns. It was created at 
a temperature of 140 degrees Celsius for a period of 60 days, c) NV-1.9, Slide O-1346 #37, 472 years, D) NV-2.8, 2.8 mi-
cron hydration on obsidian in our lab for periods of 10 days at 150oC, (E ) NV-7.7, Slide O-1346 #53 7.7 micron 7,747 

years (scale replaced by rim reading).

2. ΜΕΤΗODS  

All the analyzed images were manually 
segmented, extracting only the hydration belts. The 
resulting images were then binarized: hydration belts 
were represented in white pixels, while the glass and 
body of obsidian were represented in black pixels 
(Schindelin et al., 2015; Schneider et al., 2012) (see, 
Fig.5). The detailed protocol of these processes is 

given in Segmentation and binarization protocol 
using ImageJ 1.54 open source based on java 
software, APPENDIX. The images provided were not 
all scaled and rescaling was applied based upon a 
reference image. This induces some uncertainties 
which are taken into account in the final drawn 
conclusions in the estimation of the dates. In future 
calibrated images are most needful. 
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(A) 

 

(B) 

 

 

 

 

(C )  (D) 

Figure 5. A) the original image from the microscope for the 180oC sample, BH B) Lookup Table (LUT) for original image, 
A, to identify better the hydration belt for segmentation, C) the segmented image, of (A) using (B), and D) rotated hydra-

tion belt (left brown), binarized (center black) and potential water (right), depicted by black pixels. 

The number of pixels for each hydration belt was 
extracted. Subsequently, the total number of white 
pixels (representing hydration belts) in the images 
was quantified.  

All images were normalized to Napa Valley because 
the size of images was of different size. Napa Valley 
1429*1072 pixels were preserved (because were the 
biggest images as size). The African 800*600 were re-
scaled to 1429*1072, the Orito 800*600 were rescaled to 
1429*1072 and the Bodie Hills 320*240 were rescaled to 
1429*1072 pixels. All these operations were performed 
using the open-source software ImageJ 1.54f (Pearson, 
1995; Stevenson et al., 1998; Rogers, 2008a). (see: AP-
PENDIX Fig.A1, Fig.A2. Table A1 gives a summary of 
all obsidians studied hydration belts and the hydration 
layers and percentage of full images for the 14 samples. 
All images were rescaled to 1429*1072 according to 
Napa images). 

In parallel to image pixels, depth data regarding 
the thickness in microns of the hydration belts were 
used. 

The dating of the age of the obsidian samples was 
done based on two alternative approaches. A) power 
law equations, and B) growth rate calculations. 

Power law: Power law indeed represents a 
mathematical relationship where a change in one 
quantity is proportional to a power of the change in 
another quantity, regardless of their initial values. 
This means that one quantity varies as a power of the 
other, and the exponent in the power law equation 
determines the nature of this relationship. We used 
power trendline from Microsoft Excel. A power 
trendline is a curved line that is particularly suitable 
for data sets where measurements increase at a 
consistent rate.  

The formula of power law is:  

𝑦 = 𝑎𝑥𝑏 (8) 
"𝑦" represents the dependent variable, (pixels/yr 

or microns /yr (vertical axis). 
"𝑥" represents the independent variable, Tempera-

ture (horizontal axis). 
"𝑎" is the coefficient. 
"𝑏" is the exponent or power. 
The values of "a" and "b" are determined by Excel 

based on the data points to provide the best fit for the 
power trendline. One can use this formula to make 
predictions or analyze the relationship between our 
variables. 
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Growth rate: The growth rate, denoted as "Gr" is a 
measure used to quantify the rate at which a specific 
quantity, such as in our present case the hydration 
layer in pixels, increases or decreases over a particular 
period. It is typically expressed as a percentage or a 
decimal and indicates the relative change in the quan-
tity's value over time. The growth rate can be calcu-
lated using the following formula:  

𝐺𝑟 =
𝐼𝑛𝑐𝑟𝑒𝑎𝑠𝑒 𝑜𝑓 ℎ𝑦𝑑𝑟𝑎𝑡𝑖𝑜𝑛 𝑞𝑢𝑎𝑛𝑡𝑖𝑡𝑦 𝑓𝑜𝑟 𝑇2

𝑜𝑟𝑖𝑔𝑖𝑛𝑎𝑙 ℎ𝑦𝑑𝑟𝑎𝑡𝑖𝑜𝑛 𝑞𝑢𝑎𝑛𝑡𝑖𝑡𝑦 𝑓𝑜𝑟 𝑇1
 (9) 

Hence, for the following developments the respec-
tive Gr should be Tn/Tn-1, where T is the time or tem-
perature quantity. This formula gives the rate of 
change as a proportion of the initial quantity. If ex-
pressed as a percentage, one can multiply the result 
by 100 to obtain the percentage growth rate. The 
growth rate is defined as the ratio of pixels for succes-
sive agents of temperature or dates over the pixels of 
immediately earlier agent. A relevant term is the hy-
dration rate which for its computing in earlier times 
scholars were based on the classic method by obsid-
ian-radiocarbon association (Basgall 1990).  

The power law of eq.8 was applied on the Bodie 
Hills five experimentally aged data and on the three 
Napa Valey archaeological samples. Here two 
approaches were made for both case studies: the 
experimentally aged temperature data (at high 
temperature) were plotted versus pixels per year (the 
time parameter comes in from the growth of the 
hydration layer for a specific duration in days). The 
power law derived from the 3 and 5 data points 
respectively was extrapolated back to environmental 
ambient temperatures, which are met usually in 
buried archaeological blades (10-20 oC), assigning to 
these temperatures certain values for pixels/yr and 
microns/yr.  

The Gr was applied to the two Orito, two NV 
experimentaly aged and three NV archaeological 
samples, and the five BH aged samples.  

3. RESULTS 

3.1 Hydration layer dependence on Temperature 
of Bodie Hills (BH)  

The hydration belts experimentally hydrated in 
five temperatures (T) for a time of ~2 months from BH 
have been analyzed in total pixels for the whole hy-
dration belts, 3A of Fig.2. The results are shown below 
(Fig. 6) indicating higher water per increased T. (See 
APPENDIX on Growth rates of BH data, Table A3). 
The cumulative growth rate of water due to higher 
temperature is ranging between 1.1 to 2.1 pixels / oC 
and average ~1.6 pixels/ oC (Fig.6). 

In the single growth rate per temperature, it is in-
teresting to note the 170 oC turn over point with a 
lower rate at next 180oC hydration. The inconsistency 
might be due to some degree of inhomogeneity of BH 
source (Bettinger et al., 1984). 

The pixels at 60days were converted to pixels per 
day eventually per year. The functional behavior of 
the five temperatures versus hydrated layer pixels 
/year was made applying four fitting functions (pol-
ynomial, exponential, linear, power law). We adopt 
the power law as the most appropriate complying 
with the empirical age equation (Fig.7) (see above In-
troduction and APPENDIX for the respective func-
tions Fig.A1 and Table A1). 

The power law of equation (10) for BH experi-
mental data is used to estimate hydration ages of 
known age archaeological obsidians (below).  

A=0.0006*T3.2, R2=0.92 (10) 

where A the area in pixels/yr and T the tempera-
ture. 
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(C) 

Figure 6. A) The five hydration belts (3a only hydration rim as in Fig.2) per temperature, versus total pixels, B) Cumula-
tive Growth rates for t=~60 days hydration, as BH150/BH140; BH160/BH140, BH170/BH140 and BH180/BH140. C) 

Growth rate per temperature for t=~60 days hydration as BH150/BH140; BH160/BH150, BH170/BH160 and 
BH180/BH170. The hydration belts 3a and growth rates were normalized. The original size of BH images 320*240 (76800 

pixels) were rescaled to the size of 1429*1072 Napa Valley (NV). 

It is of interest the temperature T quadratic de-
pendence (and significance) from hydration rim pa-
rameter of pixels / year. Physics and chemistry of the 
diffusion process suggests that the relationship be-
tween age (t) and rim thickness is also expected to be 
approximately quadratic, i.e., of the form of eq. (2). In 
eq.10 the quadratic relationship has an exponent 3.2. 
(see, Rogers 2006; Liritzis et al., 2004). 

Different approaches lead to similar forms have 
suggested that power laws, and particularly the val-
ues of power law exponents, capture a fundamental 

property of the observed dynamics. It has been pro-
posed that the value of power law exponents defines 
universality classes capturing the dimensionality and 
type of disorder present in the diffusion environment 
(Lee et al., 2020). In rheological properties of minerals 
and rocks power law of exponent 3-5 has been re-
ported (Karato 2013), and in biological systems 
(Novikov et al., 2014). 
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 (B) 

Figure 7. A) Power law for the five BH blades aged at five aged temperatures versus hydration layer in pixels, the dashed 
line represents mathematical reconstruction of power law behavior and on top are placed the five experimental points, 

B) microns/yr versus Temp of power law from the 5 temperatures of BH. 

Indeed, from Fick’s law of diffusion, the water dif-
fusion is concentration driven process and depends 
on environmental temperature (higher temperature 
longer hydration rims). That is the diffusion front ad-
vances inside the obsidian carrying the water content 
deeper distances from surface. What the simulated 
high temperature (than environmental ones) does in 
short laboratory time, does the much lower natural 
environmental temperatures in time.  

In accord with Rogers & Yohe (2011) the determi-
nation of a hydration rate is not a regression problem, 
but a problem of parameter optimization. Regression is 
a technique to estimate to what extent one variable 
depends on another. In the obsidian hydration the de-
gree of dependence is fully known as a priori from 
physics, so the problem is of optimizing a parameter 
(the rate) which defines the fit between data and the 

physical model. This concept of this has been ex-
plained in Liritzis (2006) attributing optimization of 
diffusion process throughout the time (the obsidian 
blade was buried) to the S-like curve of H+ profile as 
recorded by SIMS. There the surface saturation layer 
was introduced. In the present work the optimization 
parameter is taken the hydration rim/belt area meas-
ured in pixels. The obtained power law is corrobo-
rated below with Orito (Easter islands) and Napa Val-
ley (California) experimentally aged samples. 

In addition, the correlation of pixels versus hydra-
tion thickness for BH contributes to understanding 
the growth rate per temperature and hydration layer 
(Τable 1). 

We have rescaled to squares of (thickness)2 instead 
of rectangular areas. 

Table 1. BH1 data hydration layers and percentage of full images and respective hydration depths in microns. All im-
ages were rescaled to 1429*1072 according to Napa Valley images using Scale algorithm from ImageJ. 

Samples width height Total 
Hydratic 

belt 

% hydration 
belt from full 

images 

Thickness, 
μm/60 d 

SBH 140C SA 13J 1429 1072 1531888 92518 6,030 5.91 

SBH 150C SA 13J 1429 1072 1531888 98330 6,42 7.75 

SBH 160C SA 13J 1429 1072 1531888 110209 7,19 9.96 

SBH 170C SA 13J 1429 1072 1531888 169952 11,09 13.29 

SBH 180C SA 13J 1429 1072 1531888 193866 12,65 18.09 
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R² = 0,9938

0

20

40

60

80

100

120

0 50 100 150 200

D
e

p
th

/y
r

Temp

Temp Vs Microns/yr



 
112 I. LIRITZIS & I. ANDRONACHE 

 

SCIENTIFIC CULTURE, Vol. 10, No 3, (2024), pp. 101-134 

3.2 The power law function of temperature ver-
sus hydration layer 

3.2.1 Orito (Eastern Islands) 

The Orito (Easter Islands) obsidians were aged at 
160oC for 30 and 50 days. These Orito images were at 

different size compared to BH1 images and were nor-
malized to BH values. The total hydration area of 
these Orito aged obsidians normalized and the 
growth rate per day and 60 days provides interesting 
results (Table 2). 

TABLE 2. Orito aged obsidians with hydration layers normalized to Bodie Hills (BH) data, the total hydration layers in 
pixels normalized to BH of same area, the pixels of Orito hydration layers, the pixels/day, estimated pixels per 60 days 

per Orito sample, and respective pixels values deduced from BH data. 

 

Total pixels 
normal. to 
BH1 same 

area 

Hydration 
layer, pix-
els/time 

Pix/day Est. Pix/60d 
Power law from 

BH1 160oC & 170oC 

RBC-600 Optical 160oC 
/30 day 76800 4185 139 8370 (lin.) 8370 (at 170oC) 

RBC-601 Orito 160oC 
/50 day 76800 5458 109 

6550 (almost 
non-lin.) 6893 (at 160oC) 

 
The difference in the hydration area of 60d for the 

two samples RBC-600 and RBC-601 of same Orito 
(Easter Islands) obsidian source, rescaled to the same 
hydration time, is significant and around 35%. This is 
due to the non-linear development of diffusion ad-
vancement by temperature as is known from other 
studies (e.g. Ficks law) (Crank 1975). This satisfies 
however the result obtained with the Power law be-
havior of temperature against hydration growth and 
for two distant sources like Easter Islands and Cali-
fornia. 

In fact, the hydration layer size of RBC-600 at 60 
days in 160oC, becomes larger and like the respective 
BH heated at 170oC. This is explained from the growth 
(diffusion rate) which is more accelerated, because in 
linear behavior it derives from the double linear result 
of 30x2=60 days equivalent to 4185x2=8370 pixels. It 
is anticipated that this linear dependance of hydration 
when compared with the applied power law gives the 
same result of 8370 but for 170oC. Also, the faster ac-
celerated rate in the first 30 days (139pix/d for the 30d 
experiment) with respect to 50 days experiment re-
duced to 60d (109pix/d*60) confirms the similar out-

come in the starting growth rate in any obsidian hy-
dration experiment either in nature or the laboratory. 
Thus, in the following 30 days of the 60 days experi-
ment, the rate is expected lower due to non-linear de-
velopment, in the order of 79pix/day (thus, 79*30d + 
4185=6550). 

This is an excellent result which supports power 
law and the little significance of obsidians coming 
from different sources, at least, as here are the far 
apart Easter Islands and California. 

3.3 Estimating hydration age from power law of 
T against hydration belts of BH 

3.3.1 Napa Valley, California 

The variation of the hydration belts pixels for the 
five obsidian blades (three archaeological of known 
age and two aged at 140 and 150oC) is given in Fig.8 
with an expected variation between the different hy-
dration thicknesses. 

The normalized images of Napa Valley (NV) sam-
ples for width, height and total pixels are given in Ta-
ble 3. 

 

 

 

 

 

Figure 8. Hydration belts pixels for the five 
obsidian blades (three archaeological of known 
age and hydration thickness 1.9micron, 4.5 mi-
cron and 7.7 micron, and the two aged at 140 oC 

and 60 days and 150oC for 10 days. (Normal-
ized images of 1429*966 pixels for Napa Valley) 
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Table 3. Normalized images of 1429*1072 pixels for Napa Valley for the three ages and the two experimentally aged 
samples at 150oC/10d and 140oC/60d 

Samples 
 

width height 
Total, 
pixels 

Hydration 
belts, pixels 

A 1.9 microns = 472 years 1429 1072 1531888 6243 

B 4.5 microns = 2,646 years 1429 1072 1531888 44448 

C 7.7 microns = 7,747 years 1429 1072 1531888 79989 

D 2.8 micron = 150oC, 10d 1429 1072 1531888 3989 

E 5.9 micron = 140oC, 60d 1429 1072 1531888 9409 

For the three known ages samples an alternative es-
timation of these age was applied: first, following the 
average growth rate of experimentally aged NV sam-
ples, second, based on the power law of temperatures 
of BH data (Fig.7) and third, through the power law 

as Depth (microns)/year, without normalization, and 
produced ages per the T range of 10-30oC. In addition, 
these three NV ages were fit with four functions lin-
ear, exponential, logarithmic, and power law and 
used for the dating of the Ethiopean samples (Fig.9). 

 

Figure 9. Napa Valley. The three ages were fit with four functions linear (red), exponential (green), logarithmic (mauve), 
and power law (black). 

 

We keep the power law of the three archaeological 
NV samples, eq. (11): 

A = 0.0494*x1.042, R² = 0.9449       (11) 

 where A is the age and x the number of normalized 
pixels, which is used below for calculation of the two 
African cases. 

 

First, the calculated archaeological ages were 
based upon the growth rate data of the pixel/year of 
the 2 NV experimentally aged ones. The age differ-
ence lies between -6%, +16.4% and -26.5%, which 
when errors of original ages is considered this devia-
tion becomes much lower in the order of 5-10% (Table 
4).
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Table 4. A) Napa Valley three ages (left column a, b, c) and two aged data (left column d,e). Estimation of the three ages 
and virtual age for the aged samples. The average growth rate of pixels/year for the three archaeological artifacts and 

the aged ones, the average pixels/year of 2 aged ones, 3 archaeological ages and both 5 cases, their respective hydration 
rims and % age deviations from original OHD. B) ages computed from hydration rates and eq.2 by Rogers and Steven-

son 2022a, for 16, 20oC (red) and 18oC green, being the closer ages to the reported. * Based on growth rates of the two 
aged values 14.05; these are hypothetical ages if these samples were hydrated in nature under certain environmental 

temperatures. 

Sample NV in 
μm 

Total 
Norm. pix-

els 

Gr (Norm. pixels 
/ age), 

pix/year 

Known 
ages yrs, 

BP 

Computed 
ages from 
BH, eq.10 

Computed 
age based on 
Gr of 2 aged 

(NV) 

% Deviation 
between Gr 
and known 

ages 

A:1.9 
 
6243 

 
13,2 

 
472 

See Table 5 
below  

 
444 

 
-6.0 

B:4.5 
44448 

16,8  
2646 

  
3164 

 
+16.4 

C:7.7 
79989  

10,3  
7747 

  
5694 

 
-26.5 

D: 2.8 μm, 150/ 
10 days 

3989 
14,3    

296* 
 

E: 5.9 μm, 140 
/60 day 

9409 
13,8    

699* 
 

  Av. of 3: 13.5     

  Av. of 5: 13.7     

  Av. of 2: 14.05      

 
(B) 

Temperature oC Rate (μm2/1000 years) 1.9μ, 482 yr 4.5μ,2646 yr  7.7μ, 7,747yr 

20 9.889 364 2045 5990 

18 7.763 468 2609 7641 

16 6.073 594 3336 9764 

14 4.735 768 4308 12536 

12 3.679 1000 5502 16114 

The Gr of the average pixels per day for D and E in 
Table 4 was computed using total pixels /10days or 
per 60 days. The results were for D = 399 pix/day = 
20pix/day according to BH and for E = 157 pix / day 
=8pix/day according to BH. This implies that the in-
crease of 10oC increases x2.5 the hydration rate, 
which in tur n is reflected in the ratio of the “virtual 
age” estimation for D and E (681/278=2.44). 

The faster the process the greater the Gr. In fact, the 
growth rate slows down over time (potential oversat-
uration), which implies that the hydration belt does 
not expand as readily as it did in the early years. In 
actuality, the glass matrix is hydrated by water mole-
cules permeating it, which results in expansion of the 
hydrated layer. The volumetric expansion of the glass 
during the relaxing phase that releases the internal 
tension makes the stress a function of the viscosity of 
the glass (Rogers and Stevenson 2017, 122). Since re-
laxation is time-dependent, the apparent hydration 
rate at a given temperature changes over time before 
reaching a constant state. 

This relaxation process is linked to the surface sat-
uration (SS) (Liritzis 2006, 2014) which keeps shifting 
slowly to the internal and stabilizes with entering 
molecules passing through to the interior and moving 
the diffusion front to even deeper depth. 

It is observed that 7.11 and 1.8 are the Grs between 
B and A; and C and B respectively (it is from Table 3: 
B / A = 44448/6243 = 7.11 and C / B= 79989 / 44448 
= 1.8). 

The Gr of 7.11 applies to the interval ~500-2600yrs, 
which in the earlier period 2600-7700 years BP falls to 
1.80 implies that in the initial time of some 100s of 
years the water reaches quickly the SS saturation 
layer (SS=surface saturation) (Liritzis 2006; Liritzis 
and Laskaris 2020); in later older times it becomes 
slower. For the 472 to 7750 years BP the 12.8 is full 
growth rate deriving from 7.12 x 1.80.  

Second, the three Napa Valley ages are calculated 
from the BH rates. The ages for Napa from BH pixels 
/yr are given in Table 5 below for different environ-
mental temperatures, and a satisfactory result is ob-
tained for certain temperatures.
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Table 5. NV ages from data of BH power law of T versus normalized pixels of Fig.7A. The pix/yr (fourth row) for the BH 
power law eq.10 is calculated per temperature and used with the normalized pixels in the three hydrated images of NV 
samples (fifth row). Red numbers are ages in agreement to the known calculated ones. The difference in estimated tem-

perature between Rogers and ours is a constant deviation ca. 3.2-3.7oC. 

Temp. of NV 
pix/60 d, 

BH 
pix/day, 

BH 

pix/year, 5 
points of 

BH (Fig.7A) 

NV Pixels 
norm. to 

BH 

NEW NAPA AGE, 
power law for the BH 

5 points years BP 

Known 
Age for 
NV, BP 

10 0.96 0.016 5.83 6243 1071 472 

    44448 7627 2646 

    79989 13726 7747 

11 1.30 0.022 7.91 6243 789 472 

    44448 5620 2646 

    79989 10115 7747 

12 1.72 0.029 10.45 6243 597 472 

    44448 4253 2646 

90-100cm/15.76 oC 
by Rogers 

   79989 7654 7747 

13, 20-30cm, 16.23 
oC by Rogers 

2.22 0.037 13.50 6243 462 472 

    44448 3291 2646 

    79989 5923 7747 

14 2.81 0.047 17.12 6243 365 472 

0-10, cm, 17.15 oC 
by Rogers 

   44448 2596 2646 

    79989 4672 7747 

15 3.51 0.059 21.36 6243 292 472 

    44448 2081 2646 

    79989 3745 7747 

20 8.82 0.147 52.80 6243 118 472 

   52.00 44448 842 2646 

   52.80 79989 1515 7747 

Last, the third alternative is the use of power law 

correlation between depth in microns/year versus 
Temperature for BH, to calculate the ages of Napa 
Valley. From Fig.7B the new power law is:  

y= 1E-08*x4.411 (12) 

 where Y=depth/yr and X=Temp. 
The unit of distance (micron) is the same value in 

thickness no matter of the size of the hydration image, 

while the different image resolution in pixels needs 
always normalization for comparative reasons. 

The calculated ages (Table 6) using eq.12 corre-
spond to 14-18oC compared to the reported ages and 
more calibrated than the power law of T Vs pix/yr 
above. The ages are closer to the reported dates and 
to the respective temperature by Rogers (15-16oC (ear-
lier value Table 5 is 14oC) Vs 17.16 by Rogers, 13.7-
14oC (earlier 12oC) Vs 15.6 oC by Rogers, 18-19oC (ear-
lier 13oC) Vs 16.2oC by Rogers). 

Table 6. Calculated ages of NV based on the power law of BH correlation between depth in microns/year and the tem-
perature from the BH aged experiments (from Fig.7), without normalization, using only data in microns of the thickness. 
For 14-18oC shaded area the respective calculated ages in bold red are compared with the reported ones (472, 2646, 7747 

years BP with an attached error ±20%). 

Temp of BH 
experiment  472 yr 2646 yr 7,747yr 

 T 
microns/yr of Power 
Law of BH per Temp 

Calc Ages, 1.9  
microns/micr.yr-1 

Calc Ages 4.5  
microns/micr.yr-1 

Calc Ages 7.7  
microns/micr. yr-1 

10 0,00026 7375 17467 29888 

11 0,00039 4844 11472 19629 

12 0,00058 3300 7815 13373 

13 0,00082 2318 5490 9395 

14 0,00114 1672 3960 6775 

15 0,00154 1233 2921 4997 

16 0,00205 928 2197 3759 
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17 0,00268 710 1682 2877 

18 0,00344 552 1307 2236 

19 0,00437 435 1030 1762 

20 0,00548 347 821 1405 

21 0,00680 280 662 1133 

22 0,00835 228 539 923 

23 0,01015 187 443 758 

24 0,01225 155 367 629 

25 0,01467 130 307 525 

26 0,01744 109 258 442 

27 0,02059 92 219 374 

28 0,02418 79 186 318 

29 0,02823 67 159 273 

30 0,03278 58 137 235 

It has been reported that for a given age, a slower 
diffusion rate obsidian generally yields a more pre-
cise OHD age than a fast diffusion obsidian. This has 
been seen by examining the two “rate based on 
source” cases of Bodie Hills and Coso West Sugarloaf 
obsidians. With diffusion rates of 18.14 μ2 /1000 yrs 
at EHT = 20°C for Coso against 10.38 μ2/1000 years at 
20°C for BH a great difference between these two dif-
ferent sources. The differences are due to chemical 
content, structural issues, water content, melting tem-
perature during formation. The uncertainty for Coso 
is always greater than the corresponding uncertainty 
for BH, and the source rate method yields age coeffi-
cients of variation between approximately ∼13% for 
Bodie Hills and ∼26% for Coso West Sugarloaf. The 
hydration rate was then computed from the total wt% 
H2Ot. In fact, for two groups of BH source the hydra-
tion rate at 20oC for Group 1 is 11.25±0.83 μ2/1000 
years and for Group 2 it is 10.0±0.43 μ2/1000 years; a 
composite rate for all samples is 10.36±0.72 μ2/1000 
years (see Basgall 1990; Rogers and Yohe 2011; Rogers 
and Stevenson 2022b; Rogers 2013). The BH field 
source variation in water and density has been re-
ported by Stevenson et al., (2023). 

 On the other hand, the calculated hydration rates 
per temperature for the aged experiments are in Table 
4B. 

It appears that the hydration rate of aged data for 
T=20oC BH is 11% lower than that of Group 1 and al-
most like Group 2. For Lower temperatures drastic 
change occurs.  
The Arrhenius plot of aged data for T=16-20oC gives 
for the 1.9micron sample ages ±19% around the 
known age, for the 4.5micron sample ±22% and for 
the 7.7-micron sample ±28%. However, for T=18oC 
the agreement is very close to the known ages. 

The Gr of the two aged NV samples produced ages 
deviated -6%, +16% and -26% from the known ones 
without reference to EHT. Last, for the power law of 

BH applied to NV the ages were <1% different from 
the known ones for 12-14oC. 

In our approach of microns/ microns.yr-1 the cor-
responding ages per sample that are close to the 
known ones occur for temperatures of 18-19oC, 15-
16oC and ~14oC respectively, following a strati-
graphic order of depth below ground. 

Accelerated hydration of one sample from each 
group verified the hydration rate determinations 
from values of structural water content. These find-
ings demonstrate that obsidian sources may vary in 
terms of obsidian structural water and display vari-
ous rates of hydration. If not accounted for, mis-
guided obsidian dates can be produced, resulting in 
inaccurate chronological conclusions. (Rogers & Ste-
venson 2023; Stevenson et al., 2023). 

In any case the obtained ages for Porc Epic based 
on BH data verify our statement that in OHD one 
must have aged data for the source, and then compu-
ting a specimen-unique power law for a proper hy-
dration rate which will greatly increase precision. In 
cases where the obsidian sources do not differ much 
in (California and Easter Islands) the larger age differ-
ence is 5-6% for young ages and about 20% for larger 
ages. 

With our method of power law of the five experi-
mental temperatures from Bodie Hills extrapolated to 
environmental T (as pixels/yr), in the NV samples the 
1st sample of 472 years corresponds to 462 years and 
av. T 13oC; the 2nd sample 2646 years corresponds to 
2600 years and av T 14oC; the 3rd sample =7747 yrs 
correspond to 7654 and average T oC=12oC.  

Subject to the fact that these samples were found in 
a cave at different depths under surface where tem-
peratures for the first meter lie between 12-16oC (Cal-
ifornia 2015 av. T =12oC) the obtained ages are very 
satisfactory corresponding to 12-14oC where the 
depth of the sample corresponds with the anticipated 
temperature which lowers by depth. 
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Comparing NV calculated ages with the those of 
eq.2 and Arrhenius plot for 18oC our results are very 
satisfactory and concordant to those and with the re-
ported known data. Bearing in mind that the three 
samples were coming from different stratigraphy 
depth below ground the burial temperatures are 
bound to differ. In particular the 1.9 micron sample 
gave an age difference of 1 year between eq.2 and hy-
dration rate based on water content approach and Ar-
rhenius plot (Stevenson et al., 2023) and our approach 
of power law of BH for T=20oC (Table 6) i.e. the cor-
relation between depth in microns/year and the tem-
perature from the BH aged experiments (from 
Fig.7B), without normalization, using only data in mi-
crons of the thickness. 

3.3.2 Ethiopean tentative ages 

The African blades from Ethiopia, Porc Epic cave, 
Dire Dawa (Clark et al., 1984) produce tentative ages 
firstly, according to the power law and normalized 
pixels per year of the three known ages of NV data, 
secondly on BH pix/yr normalized to BH, and 
thirdly with growth rate. NV and BH data are from 
California and hence use in Ethiopean obsidian is 
very indicative but show the potential of using alter-
native methods if experimental data are available. 

First, eq.8 is used of the power law of the three 
known ages NV (whereas A is the age and x the num-
ber of normalized pixels of eq.8) for estimating inde-
pendently of other parameters the Ethiopian ages. 
The ages obtained are 19,383 years for PE-21 and 
21,600 years BP for PE-23 (Table 7).  

Table 7: African ages based on 3 NV power law for the (unknown) temperatures the 3 NV were subjected. Data on hydra-
tion rim in microns and respective pixels (1 pixel for present analysed images = 0.19 μm from 46.99 / 247 pixels measured 

by us) 

Lab. No/Sample Width Height 

Hydration 
layer 

Width 
(μm) 

Total pixels 
norm to NV 

Norm. to NV 
Hydration 

layer pixels 

% hy-
drated 

Age, years 
BP on 3 NV 
power law 

eq.11 

Ethiopian Blades - 
PE-21 600x Exterior, 
RBC-581A 

1429 1072 
46.99~247 
pixels 1,531,888 235,587 15,38 

19,384 

Ethiopian Blades - 
PE-23 600X Fissure, 
RBC-583A 

1429 1072 
43.71~ 230 
pixels 1,531,888 261,367 17,06 

21, 600 

On the other hand, in second alternative the ages 
with power law of BH of T Versus pixels/yr, non-nor-
malized (800*600 pixels image size for Ethiopian 
blades), vary between around 1,200 to 45,000 years 
BP. In same time BH images were normalized from 
320*240 to 1429*1072 pixels image size of NV, too, and 
the ages ranged between 7,000-280,000 years on these 

normalized values to NV for temperatures 10-31oC 
(Table 8). For the latter for 15-17oC (most probable) 
the calculated ages are 46-69,000 years for PE-21 and 
51-76,000 for PE23. One can realize here the compul-
sory normalization in such dating calculations. (see 
APPENDIX Table A4 for the age difference between 
PE21 and PE23).  

Table 8: African blades of normalized (to BH) hydration layers in pixels dated by BH power law data for temperatures 
10-31oC. In red are environmental expected archaeological temperatures 10-16oC and respective calculated ages. 

T based 
on BH 
power 

law 

Pixel/ 60 
Pixel / 

day 
Pixel / 
year 

PE21-AGE 
on BH 

power law 
data, eq.10 
non norma. 

PE23- AGE 
on BH 

power law 
data, eq.10 
non-norm. 

PE21 AGE 
norm. to 

same area of 
BH 

PE23 
age norm. to 
same area of 

BH 

10 0,96 0,016 5,83 40426 44850 252661 280310 

11 1,30 0,022 7,91 29790 33050 186187 206561 

12 1,72 0,03 10,45 22544 25011 140898 156316 

13 2,22 0,04 13,50 17445 19354 109032 120964 

14 2,81 0,05 17,12 13759 15264 85993 95403 

15 3,51 0,06 21,36 11031 12238 68942 76486 

16 4,32 0,07 26,26 8971 9952 56066 62201 

17 5,24 0,09 31,89 7387 8196 46170 51223 

18 6,30 0,10 38,30 6151 6824 38446 42653 
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19 7,49 0,12 45,54 5173 5739 32332 35870 

20 8,82 0,15 53,67 4389 4870 27433 30435 

21 10,32 0,17 62,75 3754 4165 23464 26032 

22 11,97 0,20 72,84 3235 3588 20216 22428 

23 13,81 0,23 83,98 2805 3112 17533 19451 

24 15,82 0,26 96,25 2448 2716 15298 16972 

25 18,03 0,30 109,69 2148 2383 13423 14892 

26 20,45 0,34 124,38 1894 2101 11838 13134 

27 23,07 0,38 140,36 1678 1862 10490 11638 

28 25,92 0,43 157,70 1494 1657 9337 10359 

29 29,01 0,48 176,46 1335 1481 8344 9257 

30 32,33 0,54 196,70 1198 1329 7486 8305 

31 35,92 0,60 218,49 1078 1196 6739 7477 

Third, making use of the Gr of the NV obsidians 
(the 3 and 5 averages from Table 4 in pixels/yr of 
three archaeological NV and the 2 aged ones), the 
ages calculated as pixels of Ethiopian samples (Table 
8) ranged between about 17,000 years and 20,000 
years BP. 

For the Gr growth rate, we also use the ratio of 
(Hydration layer width in microns of the two Ethio-
pian samples, over, the microns per year from BH) for 
each temperature for the two samples and produce T 

versus age (Fig.10). This Gr alternative is using the BH 
temperature Versus microns/yr power law, eq.12, 
and the depth of the two Ethiopian samples and the 
ages computed are shown in Table 9 below which 
gives the age data for T=10-30 oC. From Table 10 and 
Fig.10 the ages are 31,000-57,000 years BP for T=13-
15oC. 

Between 13-20 oC ages vary between 57,000 to 8,500 
years BP and for 13-17oC between 57,000 -17,000 years 
respectively.

 

Figure 10: Temperature versus age for the PE-21 Ethiopean sample. 
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Table 9. A) Ages of the 2 Ethiopian blades and their ratio. Based on BH T Vs microns/yr power law, eq.12, the depth in 
microns from the Ethiopian samples the age is computed as Ethiopian hydration depth / hydration depth per year from 

BH. A difference of ca 7% as in their respective hydration thicknesses. Bold the most possible T. B) Ages per temperature 
based on hydration rates calculated from Arrhenius plot. 

(A) 

ToC 
Age, years BP, PE-21 
Microns/Microns.yr-1 

Age, years BP, PE-23 
Microns/Microns.yr-1 

Ratio 

10 182391,9 169660,5 1,07504 

11 119790,5 111428,9 1,07504 

12 81608,8 75912,33 1,07504 

13 57332,56 53330,63 1,07504 

14 41346,11 38460,07 1,07504 

15 30497,69 28368,88 1,07504 

16 22942,05 21340,65 1,07504 

17 17558,82 16333,17 1,07504 

18 13645,78 12693,28 1,07504 

19 10750,37 9999,969 1,07504 

20 8573,579 7975,125 1,07504 

21 6913,471 6430,896 1,07504 

22 5630,915 5237,866 1,07504 

23 4628,326 4305,259 1,07504 

24 3836,133 3568,363 1,07504 

25 3203,997 2980,351 1,07504 

26 2694,995 2506,879 1,07504 

27 2281,707 2122,439 1,07504 

28 1943,531 1807,868 1,07504 

29 1664,822 1548,614 1,07504 

30 1433,585 1333,518 1,07504 

 
(B) 

Sample/ ToC 20 18 16 14 12 

PE-21 223131 284664 363920 470000 602000 

PE-23 192986 246134 314662 406382 520435 

The difference between PE-21 and PE-23 using BH 
temperature Versus depth in microns/microns.yr-1 
power law is around 7% (See APPENDIX Fig. A3). 

Applying the Arrhenius plot of BH data to Ethio-
pian gave ages extremely higher than expected from 
the stratigraphy of earlier reported sampling and da-
ting at the cave site (>200,000 years or early middle 
stone age to late early stone age). 

The temperature in the air outside is generally 
higher or more variable than the temperature inside a 
cave. It is known that in hot weather, caves are cooler 
than the air outside and in cold weather, caves may 
feel warmer than the outside air. This is why caves are 
often sought for shelter, especially in prehistoric soci-
eties, in extreme conditions, providing a naturally 
regulated temperature environment. At shallow 
depths, soil temperature is usually more stable than 

air, and air temperature can be higher or lower de-
pending on external influences. At greater depths, 
soil temperature tends to be slightly higher than air 
temperature due to geothermal heat retention. Soil 
temperature varies with depth, but fluctuations de-
crease as depth increases, stabilizing at around 3-5 
meters before geothermal heat becomes significant. 
These uncertainties reflect age approximation in our 
present cases. 

It is known that across central Africa annual aver-
age air temperatures range from 24- 26°C and in soil 
is lower depending on the burial depth. But around 
the site Dari Dawa (Pork epic excavation) Ethiopia to-
day average is 23oC in mean air temperature. In a 
cave the temperature could vary with depth and are 
less than open air temperature. Then the cave temper-
ature gives the potential LSA age for these two blades 



 
120 I. LIRITZIS & I. ANDRONACHE 

 

SCIENTIFIC CULTURE, Vol. 10, No 3, (2024), pp. 101-134 

despite the power law of pixels area, eq.10, and tem-
perature, which was based on the experimentally 
aged California obsidian (BH). 

Clark et al., (1984) estimated the effective tempera-
ture to 24.8oC, based on an equation that depends on 
the mean annual air temperature; in turn their eq.2 
gave 61-77,000 years. This is not correct because the 
aged experiments were not hydrated properly. The 
experiment by Joe Michels in this case study is seri-
ously flawed in its design and should not be used. He 
used hydrating glass in 500ml of distilled water, 
which is a hydration-dissolution experiment. The hy-
dration layer is forming but at the same time the sur-
face is dissolving. This is why later scholars switched 
to vapor hydration many years ago. 

As the authors noted, the effective temperature of 
the Pore Epic region is a very important part of the 
rate calculation. Thus, the glacial periods with subse-
quent lowering of temperature will, therefore, slow 
the rate of hydration. However, ages of about 40,000 
BP up to 100,000 BP or more have been obtained for 
MSA occurrences from southern Africa and else-
where (Singer and Wymer 1982).  

Moreover, the burial depth, the stratigraphic integ-
rity and the exact burial position of the present dated 
samples affect greatly any obtained result. 

Estimating the temperature in caves in Ethiopia the 
22-24oC range provide the ages obtained vary be-
tween 15-20Ka and 17-22 Ka BP for the PE21 and PE23 
(Table 7) (such time range is quoted also by Phillipson 
1982). It should be noted that both Middle Stone Age 
(MSA) and Late Stone Age (LSA) levels are extremely 
rare in Ethiopia, where most of the allegedly ‘transi-
tional’ deposits have proved to be mixed or secondary 
contexts (Brandt 1986, 62; Fernández et al., 2007). 
Therefore, the obtained ages are tentative due to the 
abovementioned unknown factors. 

DISCUSSION 

BH is diverse source, and the aged experimental re-
sults have shown some inconsistency at 170oC. This 
may explain the attached errors in the power law fit-
ting. 

The long ascertained non-linear behavior of hydra-
tion thickness in the deducted OHD ages for environ-
mental temperatures extrapolated from high temper-
ature aged experiments (usually 120-200oC) have 
been considered. The prompt use of a power law de-
rives from the empirical OHD age equation and from 
the physics and chemistry of the diffusion process 
which suggest that the relationship between age and 
rim thickness should be approximately quadratic.  

The African ages obtained based on Californian ob-
sidian (power law of NV and growth rate) are for PE-
21, 17-19,000 years and for PE-23 lie between 19-21000 

years BP. Obviously the quite different obsidian 
sources have different hydration rates and until more 
data on the Ethiopean samples are available the pre-
sent attempt is indicative. However, the BH power 
law of pixels/yr for temperatures 15-17oC provide 
MSA ages (ca 41-69 Ka and ca.51-76 Ka) respectively 
for PE21 and PE23. 

The African samples come from what was thought 
of as a Middle Stone age. However, excavation in 1974 
revealed that the Middle Stone Age levels had been 
trapped behind a giant dripstone, except for the front 
half of the cave, where weathering and later deposi-
tion had caused the apparent mingling of Middle and 
Later Stone Age objects noted by the 1933 excavators. 
The site is mostly made up of points, scrapers, and 
edge-damaged blades and flake forms. The sophisti-
cated nature of the retouched and used implements, 
the cave's relative limited access and the crushed 
character of the bone debris, imply that the cave was 
probably used as a hunting camp during seasons 
when game moved into the escarpment adjacent to 
the Afar Plains. 

The major MSA habitation was located inside a 1.5 
m thick layer of indurated, coarsely laminated calcar-
eous cave breccia that was placed over this. Late pre-
historic occupation of the cave continued during the 
deposition of a 20–25 cm layer. 

The fact that the MSA items were sealed and strat-
igraphically distinct everywhere else in the cave save 
at the entrance was therefore abundantly obvious 
from their excavated section. There, after dripstone 
cutting and filling, LSA and lingering MSA artifacts 
naturally mixed. The later Stone Age was discovered 
in the uppermost layer of fine sands and loam, and 
the 1933 excavation backfill also contained 27 pot-
sherds and based on typology, a number of LSA ob-
jects. 

Despite the dating efforts of charcoal by C-14 and 
stalagmite by U234/Th230 disequilibrium dating 
(with ages ranged between 4500 to 6800 years BP) it 
seemed that the age of the MSA occupation would re-
main unknown. Initial OHD provided a testing of the 
model presented, namely that Pore Epic was the fall 
and/or spring camp of an old group of MSA hunters’ 
site.  

Summarizing it is worth noting that the alternative 
ways to date obsidians based mainly on a power law 
in the diffusion rate and hydration growth are a con-
siderable attempt within the current limitations in the 
dating errors. Despite distant sources the reasonable 
result is reinforced also from the fact that anhydrous 
chemistry has a negligible effect on hydration rate. 
Structural water, on the other hand, has a profound 
effect on obsidian hydration rate (Franchetti et al., 
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2024; Stevenson et al., 2019a). This has been reported 
in earlier studies of glass materials. 

The extent of hydration was observed to fluctuate 
in accordance with the concentration of Si-OH 
groups, which is significantly influenced by the pres-
ence of (1) modifier ions or non-bridging oxygen, (2) 
glass intermediates (such as Al2O3 or Fe2O3), and (3) 
water that is already encapsulated within the bulk 
structure of the glass. The physical adsorption of wa-
ter (hydration) on multicomponent glass exhibits no-
table differences and increased complexity when 
compared to silica, owing to the structural discrepan-
cies between the two materials. In the case of pure sil-
ica, the predominant sites available for physisorption 
on the surface are primarily constituted by silanol 
groups. Conversely, in multicomponent glasses, there 
exist additional active surface sites, including non-
bridging oxygen or alkali ions, which facilitate the en-
hanced adsorption of molecular water. The molecular 
water has the capacity to interact with non-bridging 
oxygen, leading to the generation of free modifier 
ions and H-bonded silanol groups. The silanol groups 
demonstrate a high reactivity towards the adsorption 
of molecular water. Moreover silanols follow a simi-
lar depth profile manner as H+ (Liritzis and Laskaris, 
2009, 2011), implying it following same reaction pro-
cess as hydrogen. Moreover, multicomponent glasses 
allow a higher degree of hydration, (e.g. hydrated not 
only at the surface but also in the bulk (near-surface)) 
in contrast to pure silica surfaces where the formation 
of silanol groups is usually limited to a monolayer on 
the surface (Ito and Tomozawa, 1982; Scholze 1966; 
Zhuravlev 2000). 

Other sources of error present in OHD in general 
are also the relative humidity, geochemistry, the het-
erogenic disorder and fragmentation, capacity of per-
colation (Liritzis et al., 2024) form a multiparametric 
complex phenomenon. If one isolates one of them 
which influences hydration rate, it does not give the 
real status of diffusion rate. While the high tempera-
ture experiments, the hydration depth, and growth 
rates characterize the final effect of all parameters in-
volved in the diffusion process. Hence, our alterna-
tive approaches as based on the cumulative effects of 
all parameters, they are bound to provide a more re-
liable date. It has been proposed that during water 
diffusion within the bulk glass that molecular water 
(H2Om) moves through the glass in a series of jumps 
into “doorways” or small interstitial sites (Doremus 
2002). The rate at which this process occurs depends 
upon the intermolecular distance of the host material 
matrix compared to the size of the diffusing species 
(Liritzis 2006). There is also a conversion between 
H2Om and OH which occurs at these higher temper-
atures, but this reaction is temperature dependent, 

and greatly reduced to below 400oC (Nowak and Beh-
rens 1995) and inferred not to be detectable in obsid-
ian hydrated at ambient temperature. (Anovitz et al. 
2008). Hence, the light passing through the hydration 
layer which reflects to respective pixels density may 
be related to internal stress created by more OH con-
version at higher temperature which could impact 
transmittance. The light absorption coefficient of wa-
ter is dependent on temperature and concentration of 
ions, i.e. the salinity in seawater, hydroxyls etc. 
(Röttgers et al., 2014; light absorption at a specific 
wavelength change linearly with temperature (Col-
lins 1925; Sullivan et al., 2006). In principal density 
changes with temperature do change the pure water 
absorption coefficient. When density decreases the 
number of molecules per volume or optical path de-
creases (Zhang and Hu, 2009).  

The dominant vibrational features of the two O-H 
bonds leading to major absorption maxima are sym-
metric and asymmetric, stretching, and bending of 
the molecule with wavenumbers (wavelength). In the 
liquid state rotations of the molecule are not free 
(leading to many rotational-vibrational combinations 
and millions of absorption lines) but are limited by 
hydrogen bonding in the water molecule cluster and 
are reduced to three so-called libration modes that 
have weaker influences than the vibrations and are, 
hence, at lower wavenumbers. Accurate knowledge 
of the water absorption/transparence coefficient, 
and/or its temperature correction coefficients, is es-
sential for a wide range of optical applications. There-
fore, temperature has an impact of optical density 
(and refractive index) which if fitted to a range of ex-
trapolated temperatures seems to provide a good 
modelling of optical density expressed by pixels 
quantity in the hydration layer. 

We have elaborated on the above and have shown 
that pixels could be related to temperature, maybe us-
ing water pixel intensity. The amount of light passing 
through the hydration layer has been correlated to 
temperature. The total pixels in the hydration layer 
versus temperature has been shown in Fig.5A. By pre-
processing original image using the Mode threshold 
the binarization images of the five BH aged experi-
ments were obtained (see for example the black pixels 
in Fig.5D). The light pixels which represent potential 
water as described by fractal dimensions in the hy-
drated and non-hydrated parts of archaeological ob-
sidians (see Liritzis et al., 2024) within the hydration 
belts in Fig.5C were binarized to black pixels. 

Moreover, the power law has been found in water 
pixels (black pixels from Fig.5D) versus temperature 
(Fig.11 A, B) with a relevant similar exponent about 
3.2 (Fig.7A, B) like in total pixels plot in rim (and with-
out water pixels). The related equation becomes: 
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A=0.0002*T3.26, R2=0.97 (13) 

where A the area in water pixels/year and T the 
temperature. 

In Fig.11C it is striking the high correlation be-
tween water pixels and total pixels in the hydration 

layer with a R2=1. This implies that one may use total 
pixels with temperature power law for dating pur-
poses. This has been also validated by the agent of 
depth in microns correlated by total pixels. 

 (A) 

 (B) 

 (C) 

Figure 11. A) fitting the five points by a power law function, B) Power law extrapolated to ambient temperatures, and 
C) correlation between total pixels and water pixels. 
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It should be pointed out that the ratio of water pix-
els -to -depth is not particularly accurate due to the 
errors involved in the determination of the bounda-
ries of the front diffusion and the tail at the end of hy-
dration layer. But the result of the power law extrap-
olation smooths out these differences that may occur 
at high T. 

Last, according to Mazer et al. (1991), using optical 
microscopy, the hydration rate increased by about 
x1.2 times between 90% and 100% relative humidity, 
but was not significantly affected by relative humid-
ity below 80%. 

The calculated NV ages from the BH power law 
and growth rate of experimentally aged data provide 
ages within 6-20% of the calculated earlier by OHD, 
which is a remarkable result. 

The determination of power law exponents has al-
ready been proposed to create universality categories 
that consider the dimensionality and type of pertur-
bation present in a diffusive environment. Thus, the 
power law can be used in diffusion in solids prob-
lems. Here we use it as an alternative dating process 
to the conventional Arrhenius and Friedman & Smith 
empirical equation. Though from five BH the A and E 
from rim and for certain T may produce a k, a com-
parison of ages of present approaches and earlier 
methods seem of interest and our approach is vali-
dated. 

Here we are dealing with several experiments on 
obsidians of various sources, though more geograph-
ically dispersed are needed for future work. It ap-
pears that the power law applies to all of them either 
as pixels or pixels/year, microns/year and ages ver-
sus pixels. The overall dating error of these different 
obsidian sources lies between 7-20% depending on 
the accuracy of used data. Thus, the present approach 
is a bit faster, versatile and of better precision for ac-
curacies ranging like those of older methods (if not 
better). In the Ethiopian case the age deviations be-
tween conventional method with the Arrhenius plot 
and the present alternatives are high. 

Power law is applied to four different glasses of 
different water content, and it appears that the high 
temperature data extrapolated to environmental bur-
ial temperatures compensate for the past variable 
agents of the obsidian body. It seems that the power 
law in different obsidians have a different exponent 
but relatively similar behavior in age calculation. 
Hence the power law is sensitive because the method 
was applied to a variety of accelerated hydration ex-
periments of different obsidian composition and the 
exponent varied to reflect the rate differences, thus we 
obtained satisfactory results. That is close to expected 
NV ages and reasonable ones for Ethiopian. In fact, 

the power law exponents are 3.2 for BH T versus pix-
els, 4.4 for BH T versus microns and 1.04 for ages ver-
sus pixels. 

The difference between the pixels and depth ap-
proaches is possibly due to the different input data 
and / or to the fact that micron analysis is based on a 
direct, primary determination and does not consider 
the image size, and pixel analysis were used on pos-
sibly not original images. Also, the differences may 
reflect structural status in obsidians. More accurately 
here is the power law of T versus microns because we 
know the exact value of hydration depth. In future we 
expect these exponents and associated coefficients of 
power law equation to have a corresponding value 
depending on the obsidians measured. 

The test cases are diverted with regards to sources, 
older experiments, different operators and some ab-
solute dating weakness. The present alternative da-
ting is a pioneering attempt for further development 
using more consistent samples of controlled dates. 
Porc Epic samples are not directly associated with the 
radiocarbon dates and stratigraphy problematic; 
thus, our proposed ages are tentative but fall within 
the expected archaeological phases of the site. 

At any rate, for the safer power law equation sam-
ples for dating and aged experiments must be of sim-
ilar source or other characteristics of structure. Also, 
for uncalibrated areas rescaling to known images is 
required. 

Failing to maintain these requirements an errone-
ous age result is expected. An example comes from 
the reported data for Shirataki (Japan) of 4.5μm rim 
and ca 8oC temperature (Nakazawa 2016). The ex-
pected OHD and C-14 date is ca 18,000±1000 years 
and with our approach gives ca 27,000 years BP 
(though the reported EHT is not reliably estimated 
based on last century data for a late glacial and inter-
glacial burial period of the sample).  

Overall, the three alternative approaches devised 
and proposed with prominent power law depend-
ence of temperature versus hydration area in pixels 
per duration of aging or microns, seem to open new 
directions in OHD and offer a means of dating ancient 
obsidian tools. (see APPENDIX Steps to obtain a 

date). 
The high temperature experiments made in the 

past to accommodate data in the Arrhenius plot and 
estimate the diffusion rate at ambient (burial) temper-
atures, calculated by a formula, seem to provide accu-
rate pixels of hydrated area per reasonable estimated 
environmental temperature values due to power law 
dependence.  

The limitations of the power law dating (beyond 
similar obsidian sources) on pixels image data lie in 
the manner of taking images by microscopes their 
magnification and resolution (e.g. the Becke lines at 
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both the rim/mounting medium causing the hy-
drated/unhydrated glass boundary to be gradational, 
not sharp, Anovitz et al., 1999), hence normalization 
which is always recommended. More data is required 
to investigate the power law exponents. At any rate 
even though the hydration depth is the basic param-
eter to OHD is capable but not sufficient for the study 
of diffusion and the determination of age. The SIMS 
H+ profiling as well the fractal valuation of hydration 
layer have demonstrated the need for an additional 
agent to account for submicron variations in the hy-
dration layer flow. Hence any new OHD develop-
ment may or may not turn back to older methods and 
it is a worthy attempt.  

CONCLUSION 

The produced thin sections, experimentally in-
duced hydration, the image processing methodology 
and analysis are academically sound and properly 
placed in the frame of current and past research. We 
have provided appropriate evidence and reasoning 
for the conclusions made regarding the use of the dif-
fused layer developed per aged experiments at high 
temperatures in obsidian artifacts.  

A model is proposed and a power law formula to 
convert image data (pixels and thickness) to ages. The 
known temperature dependence of hydration can be 
approximated from available soil effective tempera-
ture data and hence the OHD can be achieved 
through three ways. From the power law of Temper-
ature versus hydration layer pixels area, the growth 
rate of the hydration layer per temperature, from 
power law of known OHD ages and their hydration 
layer pixels and from power law of T versus the thick-
ness in microns/year. 

The three obsidian sources (and artifacts) were ap-
proached by the following methods. For the Orito 
(Easter Islands) the study the hydration layer was 
based on BH temperature power law at 160oC and 
compared to aged Growth rate; for Napa Valley the 
dating was based on the growth rate of experimen-
tally aged NV samples, on the BH power law of tem-
peratures versus area pixels, and on the power law of 
depth/year and the temperature without normaliza-
tion. The Ethiopean dating was based on the three NV 
ages as power law and normalized pixels per year, on 
the BH power law (pixels/yr) normalized to BH and 
for different temperatures, on the growth rate of NV 
applied to Ethiopian, and on the power law of BH of 
Temperature versus the depth (microns/yr). 

The power law of microns versus temperature is 
preferred to power law of pixels versus T because 
does not import image sizes and hence no normaliza-
tion is required. The growth rates on the other hand 
do not include a functional dependence but only a ra-
tio which is the function of time. In the initial diffu-
sion the rate is not of the same order as in longer times 
explained by the quadratic dependence of diffusion 
with time and the power law found here. Moreover, 
the close to surface saturation layer provides a virtu-
ally new start of diffusion that eventually makes the 
variation of water follow two mechanisms, one based 
on Fick’s law and another exponential like that tends 
to zero at the hydration tail.  

This novel research makes a significant contribu-
tion to the academic field of the diffused obsidian and 
its hydration dating. More geographically and com-
positionally diversified obsidian sources are needed 
to verify and clarify the power law relationship, and 
this is the goal of our next work. 
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APPENDIX 

Activation Energy, E 

The activation energy, E, in the context of chemical reactions, represents the minimum energy required for reactants to 
reach the transition state and form products. It is usually expressed in joules per mole (or kilojoules/mole). Whether E is 
dependent on a source or burial environment depends on the context of the reaction or process being studied. Let's clarify: 

Source or Burial Environment Effects on E: 

1. Chemical Reaction Characteristics: 

• Intrinsic Property: The activation energy is an intrinsic property of a chemical reaction and depends on the specific 
reactants, products, and reaction pathway. This means E does not inherently depend on external conditions like the source 
or burial environment unless those conditions alter the reaction dynamics. 
1. Temperature and Pressure Influence: 

• Environmental factors such as temperature and pressure, which vary in source or burial environments, can influence 
the rate constant of the reaction through the Arrhenius equation (4). While E is considered constant for a given reaction, 
changes in temperature (common in burial environments) can indirectly affect observed reaction rates. 

3. Physical and Chemical Changes in the Environment: 

In burial environments, diagenetic changes (e.g., mineralization, organic matter transformation) might alter the reactants 
or reaction pathways, effectively leading to a new E. 
Catalysts, present in certain source environments, can lower effective activation energy by providing an alternative reac-
tion pathway. 

4. Environmental History: 

Source or burial environments can determine the composition of reactants (e.g., organic molecules in sedimentary basins), 
affecting which reactions are possible and their associated activation energies. 

Conclusion: 

E itself is not directly a constant of a source or burial environment but is tied to the specific reaction and its pathway. 
However, the environment influences the reaction conditions, and potentially the effective E by altering pathways or 
providing catalysts. 
 

Segmentation and binarization protocol using ImageJ 1.54 open source based on java software 
 
Step 1: Image Import 
1. Open ImageJ. 
2. Navigate to File > Open... and import the target image(s). 
3. Ensure the images are compatible with ImageJ (e.g., .tif for high-resolution analysis). 
Step 2: Apply a LUT 
1. To enhance visualization, convert the image to a Look-Up Table (LUT): 
 - Go to Image > Lookup Tables > Select LUT... and choose the appropriate LUT (e.g., "Grayscale" or "Fire"). 
2. If needed, simplify the image by converting it to 8-bit: 
 - Go to Image > Type > 8-bit. 
Step 3: Manual Segmentation of the Hydration Belt 
1. Use the Freehand Selection Tool in the toolbar to outline the boundaries of the hydration belt manually. 
2. Adjust the selection as needed: 
 - Use Edit > Selection > Enlarge... or Contract... to fine-tune the boundary. 
3. Save the selection: 
 - Go to Edit > Selection > Save Selection... to retain a reusable version of the boundary. 
Step 4: Create a Binary Mask 
1. Convert the selected boundary to a binary mask: 
 - Navigate to Edit > Selection > Create Mask. 
 - This creates a binary image with the hydration belt as the white region and the rest as black. 
2. Refine the mask: 
 - Use Process > Binary > Erode or Dilate to improve edge definition. 
 - Optionally, fill gaps within the mask using Edit > Fill. 
Step 5: Extract the Hydration Belt from the Original Image 
1. Combine the mask with the original image: 
 - Go to Process > Image Calculator..., select the original image and mask, and apply the operation AND or Multiply. 
2. Save the resulting image, which isolates the hydration belt. 
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Step 6: Rotate the Segmented Hydration Belt 
1. Rotate the extracted hydration belt: 
 - Go to Image > Transform > Rotate..., and input the desired rotation angle. 

2. Save the rotated image: 
 - Use File > Save As... to preserve the rotated output. 
Step 7: Binarize the Rotated Hydration Belt 
1. Convert the rotated image to a binary format: 
 - Go to Image > Adjust > Threshold... and adjust the slider until the hydration belt is clearly segmented. 
2. Apply the threshold: 
 - Click Apply to finalize the binary transformation. 
 - The hydration belt will now appear as a black-and-white binary image (white for the belt, black for the background). 
(Schindelin et al., 2015; Schneider et al., 2012) 

 
Hydration layer dependence on Temperature of Bodie Hills 
The three equations of the five temperatures versus hydration layers in pixels are given in Figure A1. 

(A) 

(B) 

(C) 

Figure A1. Fitting function of the 5 temperatures of BH1 by a) polynomial, b) linear, and c) exponential laws, with ex-
trapolated (dashed) points. 
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Table A1: The power law of BH1 five temperatures hydration rim versus pixels extrapolated from 10 to 300 oC. In red 
the used data.  

Temp.oC Power Law with 5 points 

20 8 

30 30 

40 76 

50 155 

60 277 

70 454 

80 697 

90 1016 

100 1424 

110 1932 

120 2553 

130 3299 

140 4637 

150 4926 

160 5528 

170 8520 

180 9723 

190 11122 

200 13107 

210 15323 

220 17785 

230 20506 

240 23500 

250 26781 

260 30365 

270 34266 

280 38498 

290 43077 

300 48017 

 
A summary of all obsidians studied hydration belts is given in Fig.A2 and Table A2. 
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Figure A2 Normalized hydration layers of 1429x1072 Napa Valley image. 

 

Table A2: Hydration layers and percentage of full images for the 14 samples. All images were rescaled to 1429*1072 ac-
cording to Napa Valley images. 

Samples width height Total 
Hydratic 

belt 

% hy-
dratic belt 
from full 
images 

African Blades - PE-21 600x Exterior 1429 1072 1531888 235587 15,37887    

African Blades - PE-23 600X Fissure 1429 1072 1531888 261367 17,06176    

Napa A 1.9 microns = 472 years 1429 1072 1531888 6243 0,407536    

Napa B 4.5 microns = 2,646 years 1429 1072 1531888 44448 2,901518    

Napa C 7.7 microns = 7,747 years 1429 1072 1531888 79989 5,221596    

Napa Experiment D 2.8 micron = 150 10 1429 1072 1531888 3989 0,260398    

Napa Experiment E 5.9 micron = 140 60 1429 1072 1531888 9409 0,614209    

RBC-600 Optical 160C 30 day 1429 1072 1531888 83745 5,466783    

RBC-601 Orito Optical 160C 50 day 2 1429 1072 1531888 108758 7,099605    

SBH 140C SA 13J 1429 1072 1531888 92518 6,039475    

SBH 150C SA 13J 1429 1072 1531888 98330 6,418877    

SBH 160C SA 13J 1429 1072 1531888 110209 7,194325    

SBH 170C SA 13J 1429 1072 1531888 169952 11,09428    

SBH 180C SA 13J 1429 1072 1531888 193866 12,65536    
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Different obsidians (sources) hydrate with different growth rates in natural hydration or experimentally lab- induced hy-
dration. 

Growth rates of BH are given in Table A3. 

 
Table A3. Bodie Hills BH1 Growth Rates. 

 Total 
pixels 

Hydratic 
belts 

% Growth rate 

BH 140C A 
13J 

76800 4637 6,03776   

BH 150C A 
13J 

76800 4926 6,414063 1,062325 1,062325 

BH 160C A 
13J 

76800 5528 7,197917 1,19215 1,122209 

BH 170C A 
13J 

76800 8520 11,09375 1,837395 1,541245 

BH 180C A 
13J 

76800 9723 12,66016 2,09683 1,141197 

    1,547175  

 
Regarding the OHD in the set of aged Napa Valley images we use the hydration band measurements with bands devel-
oped on an obsidian source (Napa Valley in northern California) for which a hydration rate was previously calculated 
from associations with obsidian specimens and features that had been radiocarbon dated. Our experience has shown that 
hydration rates can be calculated from the comparison of hydration band measurements of an unknown source with the 
known source (Napa Valley). To add to the complexity of the study of hydration, lab created hydration has shown that 
some geochemically identified obsidian sources have multiple hydration rates, but standard XRF analyses cannot sort 
them. 
The difference in the ages of PE-21 and PE-23 the 2 African blades based on the power law of BH1 T versus microns/mi-
crons.yr-1, a difference of ca 7% as in their respective hydration thicknesses is shown in APPENDIX Fig. A3. 

 

 

 

Figure A3: Difference in the ages of PE-21 and PE-23 2 based on the power law of BH1 T versus years. 
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Table A4. A) Ages of the 2 Ethiopian blades and their ratio. Based on BH1 T Vs microns/yr power law, the depth in mi-
crons from the Ethiopian samples the age is computed as Ethiopian hydration depth / hydration depth per year from BH. 
A difference of ca 7% as in their respective hydration thicknesses. B) Ages per temperature based on hydration rates cal-

culated from Arrhenius plot. 

(A) 

ToC 
Age, years BP, PE-21 

Microns/Microns.yr-1 
Age, years BP, PE-23 

Microns/Microns.yr-1 Ratio 

10 182391 169660 1,07504 

11 119790 111428 1,07504 

12 81608 75912 1,07504 

13 57332 53330 1,07504 

14 41346 38460 1,07504 

15 30497 28368 1,07504 

16 22942 21340 1,07504 

17 17558 16333 1,07504 

18 13645 12693 1,07504 

19 10750 9999 1,07504 

20 8573 7975 1,07504 

21 6913 6430 1,07504 

22 5630 5237 1,07504 

23 4628 4305 1,07504 

24 3836 3568 1,07504 

25 3203 2980 1,07504 

26 2694 2506 1,07504 

27 2281 2122 1,07504 

28 1943 1807 1,07504 

29 1664 1548 1,07504 

30 1433 1333 1,07504 

 
(B) 

Sample/ ToC 20 18 16 14 12 

PE-21 223131 284664 363920 470000 602000 

PE-23 192986 246134 314662 406382 520435 

 

Steps to obtain a date 
 
Uncalibrated images (not in scale) 
1.In a thin sectioned image of dated sample apply protocol of segmentation and binarization and measure the number of 

pixels of the rectangular hydration belt. 
2. Similarly measure the number of pixels /duration (transform to per year) of experiments of hydration areas of the aged 
experiments at high T (e.g. 140, 150, 160, 170, etc). A)If the source of the sample is known from chemical analysis then the 
ageing is applied to similar source sample from lab induced experiments or published images of same source. B) If the 
provenance is unknown then one relies on available published data of othrer sources like in present article. 
If the resolution of the uncalibrated images are diferent the images (pixels /duration) will be rescaled according to the 
high resolution images, like in our article all images were rescaled to 1429*1072 according to Napa Valley images or the 
BH for Orito. 
3. Apply Power Law like equation (10) from Step 2A extrapolating to lower T. If Step 2B is used then present BH 
experimental data can be employed to estimate hydration age (eq.10, Fig.7A). 
 
Calibrated Images (scaled to microns) 
1.In a thin sectioned image of dated sample measure the rim in microns (Fig.4) 
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2. Similarly measure the number of rims in microns /duration (transform to per year) of experiments of hydration areas 
of the aged experiments at high T (e.g. 140, 150, 160, 170, etc). A)If the source of the sample is known from chemical analysis 
then the ageing is applied to similar source sample from lab induced experiments or published images of same source. B) 
If the provenance is unknown then one relies on available published data of other sources like in present article. (the 
resolution is not necessary because these are scaled data) 
3. Apply Power Law of equation (12) from Step 2A extrapolating to lower T. If Step 2B is used then present BH experi-
mental data can be employed to estimate hydration age (Fig.7B, eq.12). 
 
Growth Rates 
1. In a thin sectioned image of dated sample measure the rim in microns or pixels (Fig.4, Fig.6) 
2.From Step 2 above: Estimate the total (normalised) pixels or microns/time of aged hydration layer.  
Growth rate (pixels/year or microns/time) per temperature for hydration duration t1 as ratios of pixels/time. In hydration 
belts for uncalibrated images the growth rates must be normalized. In our case the original size of images is rescaled (in 
our case BH images 320*240 (76800 pixels to the size of 1429*1072 Napa Valley). 
Then calculate age from step 1 (pixels or microns) divided by step 2 (pixels/time or microns/time). 
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